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Working with specialized literature is a core element of many scientific disciplines. It
is difficult to imagine a report for a project, master’s thesis, or dissertation in which
previous research has not been systematically analyzed and presented (Creswell,
2016, pp. 58–66). As more and more publishers make their journals and publications
accessible online, the creation of literature reviews has become easier and more
efficient. MAXQDA is suitable for day-to-day work with literature as well as the
creation of literature reviews (e.g., the preparation of theory chapters and research
reports) as well as for systematic reviews for the preparation of research results for
meta-analysis. In particular, MAXQDA can be used to manage notes and create
summaries to support the writing process. When working with literature, biblio-
graphic information (author, year of publication, etc.) must be distinguished from the
content of the literature. MAXQDA focuses primarily on the content and is not a
specialized reference management software; however, data from such programs can
be imported into MAXQDA for further processing.

In This Chapter
• Working with bibliographic data
• Importing data from reference management programs and (online)

databases
• Everyday tasks with literature and summaries
• Conducting literature reviews
• Possibilities for the creation of systematic reviews
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Working with Bibliographic Data from Reference Managers

MAXQDA offers the possibility to import bibliographic data from reference man-
agement software such as Mendeley, Endnote, Citavi, and Zotero. Like MAXQDA,
these reference managers use project files, meaning databases, containing all col-
lected bibliographic information. The smallest unit of such a project is a biblio-
graphic reference (author, title, etc.) which may also contain links to websites,
keywords, abstracts, full texts, and other information.

MAXQDA can work with all reference management programs that are able to
export their databases in RIS format, a standard format for bibliographic data. For
Citavi, this can be done via the “File” menu with “Export > Export” and for the free
Zotero program via “File > Export Library.” A detailed description of the RIS
format can be found on Wikipedia under https://en.wikipedia.org/wiki/RIS_(file_
format). RIS data contains tags, each consisting of two letters, to which the
corresponding information is attached.

Some important tags include:

• TY—Type of reference, always introduces a new entry
• ID—Unique identification number for the entry
• AU—Author
• TI—Title
• PY—Publication date
• ER—Must appear at the end of an entry for closure of said entry

Source specification in RIS format appears as follows:

TY – BOOK
AU – McLuhan, Marshall
AU – Fiore, Quentin
TI – The medium is the message
PY – 1967
CY – New York
PB – Bantam Books
ER –

A detailed description of all RIS tags can also be found on Wikipedia.

Import and Automatic Pre-coding in MAXQDA
RIS data can be imported via the option Bibliographic Data in the Import ribbon tab
of the main menu. First, a dialog window with import information will appear,
followed by a dialog window, in which the file with the extension RIS or TXT can be
selected. During the import process, the following occurs (Fig. 14.1):
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• A new document group is created in MAXQDA, whose name begins with “RIS”
and is supplemented with the name of the import file.

• Each reference from the RIS file is added to the newly created document group as
a separate document. The entries remain in their original order. The imported
documents are identified with a book symbol in the “Document System.”

• The document names are structured as follows: <Author>—<Year>—<ID>.
Empty fields may be indicated with the “?” symbol. In the case of multiple
authors, only the first author’s (last and first) name will appear, followed by the
abbreviation “et al.”

• The newly created documents contain the information to the right of the tags. The
tags themselves will not be imported.

• A new top-level code, “RIS,” will appear in the “Code System,” which contains
all the RIS tags used in the import file as subcodes, for example, “TY—Type of
reference.”

• Upon import, all documents will be automatically pre-coded, meaning each text
element will be coded with the corresponding tag code.

Five pieces of information which may also be important for future selections are
also stored as document variables:

• RIS_Type (Type of reference)—Text
• RIS_Author (First author)—Text
• RIS_Title (Title)—Text
• RIS_Reference-ID (Identification number)—Integer
• RIS_Year (Year of publication)—Integer

These variables are created as system variables and cannot be changed by the user
(Fig. 14.2).

RIS tags as codes

Document symbol: book

Pre-coded bibliographic information

Fig. 14.1 Imported RIS data in MAXQDA
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Working with Bibliographic Data and Exporting
Following import and automatic pre-coding, the bibliographic data is made available
in MAXQDA as normal text. This means the data can be searched, coded, linked,
and edited and have memos added for further qualitative and quantitative content
analysis. Now one can answer questions such as:

• How often are specific authors named?
• Which topics are represented?
• How has the focus on specific topics shifted?
• Are there more journal articles or monographs on a specific topic?
• To what extent have journal article titles changed over time?

Naturally, Visual Tools and all of the other MAXQDA functions, such as
graphics and statistics functions, can be applied to this data. On the basis of the
automatic pre-coding, documents of a specific type can be selected, for example,
only journal contributions or only articles in compilations.

Bibliographic data can be exported from MAXQDA in RIS format, for example,
to a reference management program. The export function can be accessed via
Reports > Export > Bibliographic Data as RIS File. All documents of a project
containing bibliographic data and therefore identified with a book symbol will be
exported in a RIS file (encoding: UTF-8).

Organizing and Analyzing Literature and Summaries
with MAXQDA

Working with literature—both online and offline—is one of the most important
activities not only in research and teaching but also in NGOs and institutions and for
the purpose of market research. Characteristics of working with literature are finding
and reading relevant works, identifying and marking important points, understand-
ing arguments, and extracting, compiling, and comparing texts. MAXQDA is an
excellent tool for these daily tasks. Elgen Sauerborn (2014) and Uta-Kristina Meyer

Fig. 14.2 Variable values for each document
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(2014) reported in their blog posts how they created summaries and notes while
reading relevant literature for their research and managed them with MAXQDA.
Based on their work and our own experiences, we suggest the following procedure:

• As far as possible, all available literature sources for the research are imported
into a MAXQDA project.

• Summaries are created as individual documents in MAXQDA, whereby the
reference information (author, year, title) is used as the document name, ideally
in the exact citation style which will be used in the later bibliography. Conse-
quently, authors can be easily searched for in the “Document System” by means
of the document name.

• In-document memos, further information about the sources, can be managed,
such as questions arising from particular arguments, criticism of particular works,
or whether the source is important for one’s own work.

• The “Code System” is created following the chapters of the report, with codes
following the same order as in the later work. Summaries or parts of the original
documents suitable for citation will be coded with these codes.

• As the report is written, the corresponding codes are activated so all of the
important coded segments are compiled in the “Retrieved Segments” window.

• This basis makes writing easy, eliminating the risk of overlooking an important
point or reference and helping the user to “write up” the work.

• After completing the work, the sources, summaries, notes, and coded segments
remain available. When one is working on a similar topic at a later date, this work
can be accessed, creating a foundation on which to add further references and
summaries.

Creating Literature Reviews with MAXQDA

What is meant by the term “literature review”? Arlene Fink provides the following
definition: “A research literature review is a systematic, explicit, and reproducible
method for identifying, evaluating, and synthesizing the existing body of completed
and recorded work produced by researchers, scholars, and practitioners.” (Fink,
2010, p. 3)

A literature review as explained in this way is conducted on a specific topic or
research question. The objective is to determine the current state of research and/or
the scientific discussion with regard to a particular field of knowledge. The focus
may be on different predetermined aspects, for example, theoretical or methodolog-
ical aspects. A literature review represents a specific form of secondary analysis, as it
is not a matter of new, independent research but rather a review of research that has
already been conducted. A literature review, like an essay, is frequently written by an
individual researcher. It systematically presents substantial research results,
identifies controversies, and summarizes the state of scientific discourse in a specific
field. A literature review is always an explanatory text, not simply a list of sources.
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Literature reviews can be created as embedded reviews (e.g., embedded within a
dissertation or research report) or as stand-alone reviews. The latter are frequently
referred to as “systematic reviews.”As a rule, systematic reviews are concerned with
the research results in relation to a specific question and with identifying any gaps in
the research. This is not usually the case with general embedded reviews, which is
not to say that these are unsystematic or eclectic. Traditionally, however, stand-alone
reviews focus more heavily on quantitative aspects.

Work Phases for the Creation of a Literature Review
Based on the work of Fink (2010, pp. 4–7); Hart (2017); Gough, Oliver, and Thomas
(2017); and Heyvaert, Hannes, and Onghena (2016, pp. 6–8), six phases for the
creation of a literature review can be identified:

1. Formulation of research questions and objectives of the review. The research
question should be precisely formulated in order to lead the review.

2. Selection of bibliographic databases, which today are normally online databases.
3. Determination of search terms within these databases.
4. Application of practical and methodological criteria for the selection of high-

quality scientific literature.
5. Conducting the review. This includes, among other aspects, import of biblio-

graphic data and eventually full texts; definition of variables such as author, year
of publication, etc.; thematic coding of significant text segments; and writing of
notes and summaries.

6. Synthesis of results and writing of the review, either in the form of a qualitative
description of results or in case of a quantitative meta-analysis as a calculation of
statistical characteristic values and measures.

MAXQDA can provide valuable support in all phases, particularly in the thematic
and content development of primary sources in phases 5 and 6. Before describing the
possibilities offered by MAXQDA for this type of work, the differences between
MAXQDA and reference management programs such as Endnote, Citavi,
Mendeley, Zotero, etc. should be considered. Endnote and the like allow the
collection, management, and citation of primary online and offline sources. The
focus of these programs is the management of bibliographic input and the creation of
bibliographies corresponding to the different regulations of a large number of
scientific journals and publishers. For example, the widely used Zotero program
(www.zotero.org) searches for bibliographic information in online catalogs and
booksellers such as Amazon and allows this information to be stored in a local
database and to be provided with keywords and metadata. Reference lists can later be
exported in various citation styles (e.g., in the widely used APA style). While
reference management programs focus on the bibliographic data, MAXQDA
focuses on the content and allows for the thematic coding and systematic, qualita-
tive, and quantitative analysis of this content. MAXQDA is therefore not primarily
used for the collection of bibliographic data (although this is possible) nor for the
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creation of reference lists for publications. However, as described above, MAXQDA
allows the user to import bibliographic data from reference management programs.

But now, we return to a description of the phases of creating a literature review
with MAXQDA. The literature review is valuable not only as it provides an
overview of current knowledge in the field, but it also situates the research within
a wider context and discussion within the scientific community. The six phases of the
creation of a literature review are described in greater detail below.

Phase 1: Formulation of Research Questions and Objectives of the Review
Similar to a research project, a literature review begins with the formulation of the
research field and question(s) as well as the objectives. However, the question is
formulated somewhat more broadly than would normally be the case for a research
project. If the focus is overly narrow, sources that are relevant but do not initially
appear to be central to the research could be overlooked. In MAXQDA, the research
question and objectives are best presented in the form of a free memo (via Analy-
sis > Free Memo) as in the following example:

Memo
Literature Search on Data Analysis and Integration in Mixed Methods
Research

The goal of the literature search is to evaluate the current state of the
discussion on the topic of data analysis/integration in mixed methods research.
Well-known authors in the mixed methods research community see the inte-
gration of qualitative and quantitative as the primary challenge of mixed
methods research. The review aims to compile the most important positions.
Since mixed methods discourse is conducted in English, only English-
language literature should be taken into account. The review will cover the
years 2014–2016 and will be limited to the leading journal on this topic, the
Journal of Mixed Methods Research.

Phase 2: Selection of Bibliographic Databases
The next step is a targeted search for sources that could present information about the
topic in question. In a traditional library, literature is identified by means of
keywords and keyword catalogs, retrieved from the shelves, then taken to the
workspace, and placed on the desk. When working with computers and searching
in appropriate databases, the principle is similar. The researcher explores databases
and scientific journals, saves search hits, and selects sources that are presumed to
contribute to the review.

Next, it is important to decide exactly where to search and what to look for, in
other words, to select the bibliographic databases and define the search terms.
Normally the databases are online, and hundreds of public and private databases
exist. The most popular international databases are PubMed (medicine), MEDLINE
(medicine), ERIC (education science), JSTOR (various), LexisNexis (economics
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and law), PsycINFO (psychology), and Social Science Citation Index and Sociolog-
ical Abstracts (social sciences) (Fink, 2010, pp. 17–21). Also to be noted are private
databases such as SpringerLink, the portal for the Springer International Publishing
AG, and the databases of journals and periodicals such as that from SAGE
Publications, which is indispensable for research in the fields of methods and
methodology.

A further consideration is whether to include only English-language sources in
the search.

Phase 3: Determination of Search Terms
After these specifications, the next step is to determine search terms. These could be
single words or combinations of multiple words. Nearly all databases offer the
possibility for advanced searches, in which one can formulate more complex
conditions, for example, linking search terms with the logical operators AND
and OR.

Example
In the Journal of Mixed Methods Research (JMMR), a search is conducted for
all entries concerning the theme “data analysis.” The search is restricted to the
years 2014–2016. Other possible search terms would be “triangulation” and
“integration,” but in the following example, the search is restricted to “data
analysis.” The search on the JMMR website (http://mmr.sagepub.com/search)
results in 57 hits.

In the next step, the compilation of results on the website can be checked
for relevance on the website, or the full list of results can be imported into
MAXQDA and checked there. In this example, it is more efficient to import
the results into MAXQDA. When exporting from the SAGE Publications
website, it is important to ensure that both the citation and the abstract are
exported. The RIS format should be selected from the list of available formats.
The file can be imported into MAXQDA via the menu function Import > bib-
liographic data.

Phase 4: Application of Practical and Methodological Criteria for the Selection
of High-Quality Scientific Literature
This phase concerns the selection of relevant literature, that is to say the literature
that was found in the database search is now examined in order to determine if it falls
within the narrower area of the research question and whether it fulfills the objectives
of the review.

Practical as well as methodological criteria of this selection process should be
documented. Practical criteria are those which relate to the practical accessibility,
language, and type of publication. For example, for a study on environmental
awareness in Europe, only results in the most common languages, possibly only in
English, would be considered. In addition, the search would be restricted to only the
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most important social science journals. Methodological criteria for this review could
be, for example, the quality and manner of sampling or the “seriousness” of the
institution carrying out the study. It is possible that for methodological reasons,
sources based on online surveys would be excluded because they used a convenience
sample.

For the earlier example of the literature review of data analysis in mixed methods
research, all of the bibliographic search hits were imported into MAXQDA. The
sources now appear in the “Document System.” Figure 14.3 shows how MAXQDA
appears after this information is imported.

The RIS format tags are found in the “Code System.” Here it can be seen that an
abstract is available for only 49 of the 57 sources. The list of document variables
displayed on the right shows that five tags are also available as variables for later
selections, namely, type of publication, author, title, ID, and year of publication.

The next step is to systematically read each abstract in order to decide if the
source is relevant or not. It is advisable to set up two (or more) new document groups
in the “Document System” to which the results can be moved according to their
relevance. The names of the document groups should indicate their functions, for
example, “Relevant sources” and “Less relevant sources.” Sources that do not
contribute to the review can be deleted immediately. If there is any doubt concerning
where to assign a source when reading the abstract, the full text can be obtained by
clicking the link coded with the tag “UR_Web/URL.” This will open the information
page in the SAGE Publications database, which contains a link leading to the full
text (assuming you have access to the sources via your library). Reading the full text
provides a solid basis on which to classify the text as relevant or less relevant.

Other variables which allow the user to make selections or comparisons and
recognize trends can be defined in this phase of the literature review. For example,

Fig. 14.3 Imported RIS file with search results in “Journal of Mixed Methods Research”
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the variable “RIS_Year” allows for the creation of a table or chart showing the
distribution of sources by year.

There may be other primary sources outside the results of the database search that
should be included in the review. In principle, all types of sources, including audio
and video sources, can be imported into MAXQDA. Sources such as books that
cannot be borrowed may only be available as scanned copies. Such scanned sources
can also be included in the literature review.

" Hints for Scanned Sources If no digitized version of a relevant source is
available, the only option is to use scanned pages. This results in a photo
or PDF file. Using software such as Adobe Acrobat, it is possible to
perform an OCR text recognition (see Chap. 3). This is strongly
recommended, as subsequently searches can be performed on words
in the text and all word-related functions in MAXQDA including
MAXDictio can be used.

If the sources have been classified according to their relevance, particularly
relevant works can be imported as full texts. It is best to create a new document
group (e.g., “Primary literature”) and to download and import full texts into this
folder. Ideally, the full text and bibliographic reference should be linked, as
described in Box 14.1.

Box 14.1: Linking Full Text and Bibliographic Reference
• Open the full text.
• Open the bibliographic reference in the “Second Document Browser.”
• Highlight the first word (or first paragraph) in the full text and select Insert

Document Link from the context menu.
• Highlight the first word (or first paragraph) in the bibliographic reference,

and select Insert Document Link from the context menu.

For many databases, particularly private databases, you may only download full
texts if you have authorization to do so. This is the case at most universities, and all
members of the university may have access. It may be necessary to log into the
university network via VPN.

Phase 5: Conducting the Review
The process of conducting a literature review varies depending on the nature of the
research questions and the objectives of the review as well as the range of the
sources. In addition, the process depends on the time available for the preparation
of the review. If little time is available, it is necessary to restrict the material and
tighten the formulation of practical and methodological criteria (see Phase 4). In this
case, the review will be based mainly on the abstracts and not on the more extensive
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full texts. The following are some of the possibilities MAXQDA offers for
conducting a literature review:

Working with Word Clouds
What are the central themes of a text and the key terms that are used? These can be
easily explored by right-clicking on the full text and selecting the option Word
Cloud. Alternatively, one can create a word cloud for parts of the bibliographic data
(titles or abstracts) by retrieving the relevant segments and starting the word cloud
function in the “Retrieved Segments” window. Nonsensical words or words that are
not relevant in the context of the review can be transferred to the stop list.

Exploring Full Texts and Working with Memos
In view of the abundance of publications available on almost every topic, one is
often not able to read an entire book or journal article. Using the context search in the
“Document Browser,” one can search specifically for the presence of key terms,
which greatly reduces the extent of text passages that need to be read intensively.
Questions which arise, alongside ideas and core statements, can then be stored as
memos attached to the corresponding text passages. The overall assessment, evalua-
tion, and criticism of a text can be stored as a document memo in the “Document
System.”

Emphasizing Important Text Passages
Reading a text and underlining important points is a common practice. One can work
in the same way when creating literature reviews in MAXQDA: five distinct colors
are available for color coding text passages. The marked passages can be easily
located at a later time. In some cases, it may be useful to mark the text passages with
a thematic code rather than color coding.

Exploring the Frequency of Words and Terms Used in the Sources
Using the word frequency function (part of the MAXDictio module), one can
analyze the frequency of words in one or more documents. In addition, a
differentiated word frequency analysis can be performed on documents, document
groups, and document sets. As with word clouds, nonsensical words can be trans-
ferred to the stop list and therefore excluded from the analysis.

Writing Summaries
Summarizing text and extracting interesting passages is one of the classic techniques
of literature work. In MAXQDA, a document group “Summaries” should first be
defined, in which all summaries and excerpts are stored. Next, select the option New
Text Document from the context menu of this new document group. A new
document will appear in the “Document Browser” in Edit Mode, where one can
start to write a summary. If the full text has been imported, it can be opened in the
“Second Document Browser,” allowing the user to read the source text and write the
summary concurrently. The text segment and the corresponding summary can be
linked using document links.
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The name of the summary should also contain the author and year; furthermore,
the summary should be linked to the bibliographic reference using the procedure
described above.

Automatic Coding of Text Segments
The text can be searched for interesting keywords and the results coded automati-
cally using the function Analysis> Lexical search. The range of text passages to be
coded can be freely selected by the user (search hit, sentence, several sentences,
paragraph). Following automatic coding, the coded segments can be retrieved and
explored further.

Manual Thematic Coding of Significant Text Passages
It is possible to code the relevant text passages when the primary text is available,
which is normally the case with journal articles. In this case, working with thematic
codes which are as close as possible to the research questions in the scope of the
review is recommended. By means of specific labeling, it is possible to indicate the
passages that are suitable for later quotation. For this purpose, a specific code, for
example, “Suitable for quotation,” can be defined. Alternatively, the comment
function or a weight score can be used. For each coded segment, a short comment
can be added, in this case, for example, “Quotation.” Later, in the Overview of
Coded Segments, you can sort by the comment column so that all potential quotes
are listed together. It is also possible to assign a weight score to any coded segment.
Later, one can retrieve just the text passages which have been coded to a selected
theme and allocated a specific weight score.

Distinguishing, Coding, and Statistically Analyzing Different Dimensions
For a specific content area in the literature, for example, the research design, specific
dimensions can be identified and defined as subcodes, for example, “Explanatory
sequential design,” “Exploratory sequential design,” or “Convergent design.” Using
the option Subcode Statistics in the context menu of the “Code System,” the
frequency of the different design types can be determined and displayed as a table
or graph.

Visual Representation of Themes and Sources
MAXQDA’s visual tools can be used very effectively for literature reviews. We
assume here that thematic coding of relevant texts has already taken place, either
manually or using automatic coding of search items.

• The Code Matrix Browser displays the themes covered and their respective
frequency per text in a comparative table.

• The Code Relations Browser displays the simultaneous occurrence of pairs of
themes in a comparative table.

• The Single-Case Model (available in Visual Tools > MAXMaps) represents the
coded themes and their respective frequencies for a selected source in a schematic
diagram.
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• The One-Code Model (also available in MAXMaps) displays a selected theme
and its coded segments, the code memo, and the memos linked to the code in a
schematic diagram.

Writing Thematic Summaries and Creating Summary Tables
This technique uses MAXQDA’s function Analysis > Summary Grid (see
Chap. 11). This makes it possible to write thematic compilations and present them
in comparative tables (“Summary Tables”). In order to use this technique, it is a
prerequisite that relevant text passages have been thematically coded beforehand.

Quantitative Evaluation of Themes
Quantitative aspects can also be relevant in a literature review. For example, it is
possible to sort and count sources according to variables (e.g., year of publication)
and answer questions such as “How are the sources distributed over time?” or “Has
the investigation of the topic ‘Data analysis/integration’ increased or decreased
during the period under study?” Statistical tables with absolute and relative
frequencies as well as bar and pie charts can be created for thematic codes and
subcodes in MAXQDA. More complex analyses including correlation analyses can
also be carried out with the STATS module in MAXQDA.

Phase 6: Synthesis of Results and Writing of the Review
After most of the work has been completed in the first five phases, it is time to
summarize the findings. When the review is written, the preparatory work of the first
five phases comes into effect, that is to say, the results of the previous work prepare
the researcher to write a well-structured text. Effectively, one can build on the
memos prepared in phases 5 and 6, as well as the displays such as summary tables,
and visual representations, in the review.

There are two types of reviews:

1. A review in the form of a qualitative description of results (descriptive literature
review); occasionally, quantitative results can also be included, such as the
number of sources, their distribution over time, apparent trends, frequency of
sub-topics, etc. The focus, however, remains a qualitative one.

2. A review in the form of a quantitative meta-analysis with calculations of statisti-
cal parameters and measures. Here, the results of statistical procedures are central,
as in the case of a meta-analysis of attitude-behavior research, where average
correlations in various spheres of activity are calculated and communicated.

Both types of literature reviews should always contain the following four parts
(Fink, 2010, pp. 206–207):

• Purpose and objectives of the review
• Methods and sampling
• Results
• Conclusions
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In the case of a quantitative meta-analysis, the methods section should be
expanded with particular attention to the description and substantiation of the
statistical methods used.

When writing the review, the following MAXQDA tools can provide valuable
assistance:

• The Coding Query, with which previously classified text segments can be located.
• Memos, particularly the free memos written in phase 5 of the work on the review,

from which passages can be copied and inserted into the final text.
• Summary tables, with which compressed summaries of sources can be effectively

compared and represented. Summary tables can also be integrated into the review.
• The word frequency functions of MAXDictio, with which the usage of specific

search items and semantic contexts can be represented.
• The graphical display options of MAXMaps, which in particular allow the

creation of concept maps.
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